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Chapter 1. Introduction 

 
The Spitzer IRS Custom Extraction, or SPICE, software provides a JAVA-based tool that allows 
the user to interactively extract Spitzer Infrared Spectrometer (IRS) spectra. The Spitzer 
automated pipeline provides default extractions, but many observing programs require further 
refinement to meet their science goals. For example, SPICE is designed to allow the user to: 
 

• Visualize the extraction performed by the Spitzer pipeline; 
• Examine features at known wavelengths in the 2D dispersed image; 
• Extract multiple targets along the slit; 
• Extract local sky spectra along the slit; 
• Re-extract target spectra after sky subtraction on the 2D dispersed image; 
• Re-extract target spectra after interpolation over e.g. bad pixels; 
• Overlay slit position, spectra from file, and line lists;  
• Perform custom extractions in Batch mode. 

 
IRS spectra are not rectilinear on the array, and so spectral extraction requires careful tracing of 
the shape of each order. SPICE provides the tools to visualize the extraction window and properly 
perform the extraction. The software provided is the same as that used in the Spitzer pipeline, so 
consistent results may be obtained. 
 
This manual serves as a brief introduction to both the SPICE interface and the Spitzer extraction 
pipeline. For a complete reference manual on IRS extraction, see the IRS Instrument Handbook.  
 

1.1 Important Documentation 

The following documents are recommended reading, and are referred to throughout this User’s 
Guide:  
 
IRS Instrument Handbook: 
http://irsa.ipac.caltech.edu/data/SPITZER/docs/irs/irsinstrumenthandbook/ 
Spitzer Data Analysis Cookbook:  
http://irsa.ipac.caltech.edu/data/SPITZER/docs/dataanalysistools/cookbook/ 
SPICE main page:  
http://irsa.ipac.caltech.edu/data/SPITZER/docs/dataanalysistools/tools/spice/ 
SPICE download page:  
http://irsa.ipac.caltech.edu/data/SPITZER/docs/dataanalysistools/tools/spice/downloadspice/ 
 

http://irsa.ipac.caltech.edu/data/SPITZER/docs/irs/irsinstrumenthandbook/�
http://irsa.ipac.caltech.edu/data/SPITZER/docs/dataanalysistools/cookbook/�
http://irsa.ipac.caltech.edu/data/SPITZER/docs/dataanalysistools/tools/spice/�
http://irsa.ipac.caltech.edu/data/SPITZER/docs/dataanalysistools/tools/spice/downloadspice/�
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1.2 Getting Started 

1.2.1 Downloading and Installing SPICE 

Complete instructions for downloading and installing SPICE can be found at 
http://irsa.ipac.caltech.edu/data/SPITZER/docs/dataanalysistools/tools/spice/. 

1.2.2 Getting Your Data 

All Spitzer data must be downloaded from the Spitzer Heritage Archive 
(http://irsa.ipac.caltech.edu/applications/Spitzer/SHA/). You will be given a choice of data 
products to download. In general it is advised that the user download both the Basic Calibrated 
Data (BCD) and Post-BCD data. While the Post-BCD products will be suitable for many 
applications, they have been highly processed. The BCD products are necessary for anyone 
wishing to carry out their own spectrum extraction, and are the usual input files for SPICE. They 
can also provide a sanity check in assessing the reality of unusual features seen in the Post-BCD 
products.  
 
The most commonly useful products available from the archive are the files with the following 
suffixes: *bcd.fits, *bmask.fits, *func.fits (individual BCDs, found in the bcd/ directory after 
downloading); *coad2.fits, *c2msk.fits, *c2unc.fits (co-added BCDs, found in the postbcd/ 
directory after downloading); *bksub.fits, *bkmsk.fits, *bkunc.fits (nod-subtracted observations, 
available for low-resolution staring AORs and found in the postbcd/ directory). A description of 
all of these products is available in the IRS Instrument Handbook.  

1.2.3 Running SPICE - a walkthrough 

When the GUI is started, the user is presented with a blank screen. To begin using SPICE an 
extraction flow must be initiated. SPICE flows are initiated using standard templates (point 
source, extended source, etc,) accessible from the File Menu. Extractions may be performed 
either upon single exposures by starting from a single BCD frame, or in batch mode for 
processing of many exposures. To get started, select File > Open SPICE generic template or File 
> Open Batch SPICE generic template. We begin here by describing the extraction of a spectrum 
from a single BCD. 
 
A droplist menu will appear with the following three options: 

Point Source with Regular Extract; 
Point Source with Optimal Extract; 
Extended Source with Regular Extract. 

 

http://irsa.ipac.caltech.edu/data/SPITZER/docs/dataanalysistools/tools/spice/�
http://irsa.ipac.caltech.edu/applications/Spitzer/SHA/�
http://irsa.ipac.caltech.edu/data/SPITZER/docs/irs/irsinstrumenthandbook/�
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Select one of the flows and click the OK button. SPICE will set up the desired processing flow. 
Default parameters will be used initially, but may be modified by the user. To begin, specify the 
input files and output directory in Initialize Parameters and Files (§2.1). SPICE will attempt to 
match the uncertainty and pixel status bitmask files (§1.5, §1.6) to the input BCD based upon the 
standard naming convention. SPICE will automatically find the appropriate default calibration 
files for the input BCD. 
 
Once the initial setup is complete, the user may specify custom parameters in any of the four 
SPICE modules (Chapter 2). New users may wish to begin by reading the overview of IRS 
pipeline processing (§1.3). The results of each module can be displayed in either the Plot or FITS 
windows (§1.7). 
 
Processing flows can be saved using the File > Save and File > Save As options. They can be 
read back into SPICE later using File > Read SPICE user-saved Template (or File > Read Batch 
SPICE user-saved Template). FITS window images can be saved or printed from the File Menu, 
while spatial profiles or extracted spectra can be saved or printed from the right-click menu in the 
Plot window.   

1.3 IRS Pipeline Overview 

The IRS extraction software replicates part of the Spitzer data reduction pipeline. A complete 
description of the pipeline may be found in the IRS Instrument Handbook, and only the extraction 
part is summarized here. Pipeline operation is controlled, in part, by configuration files referred to 
as “namelist” files. Calibration data are stored in standard calibration tables. The spectral 
extraction flow consists of five modules: 
 
Profile   

Creates a wavelength-collapsed average spatial profile of the slit used in the observation. See 
§2.3 for details. 

 
Ridge:  

Identifies the location for point source extraction by identifying the peak in the Profile output, 
or using a user-specified fractional location along the slit. See §2.4 for details.  

 
Extract:  

Extracts the one-dimensional spectrum for either point or extended sources. Flux conversion 
factors are based on standard width extractions. Extended source extraction is only calibrated 
for full slit (28 pixel width in low resolution modules). Point source extraction may also be 
performed using Optimal Extraction (§2.5.3). In this mode, the point source width is still 
employed, but extracted pixels are weighted by a standard point source profile. See §2.5 for 
details. 

 

http://irsa.ipac.caltech.edu/data/SPITZER/docs/irs/irsinstrumenthandbook/�
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Point Source Tune:  
Applies photometric “tuning” and flux conversion coefficients for point sources to the 1-D 
spectra from the Extract. The data are converted to Janskys, and the module corrects the slope 
and curvature of each order by applying the polynomial coefficients in the fluxcon.tbl file. 
This correction is based on an order-by-order comparison of calibration data to standard star 
model spectra. See §2.6 for details.  

 
Extended Source Tune:  

Applies the same steps as in Point Source Tune, but optimized for extended sources. See §2.7 
for details.  

 
The details of each module's operation are given in the corresponding module descriptions in 
Chapter 2. 
 
The extraction pipeline takes as input the two-dimensional Level 1 Basic Calibrated Data (BCD) 
dispersed image in FITS format. Each BCD has an associated uncertainty and bitmask file which 
indicates individual pixel status. The output from the pipeline is a table file containing the 
extracted spectrum, propagated uncertainties and status flags. The naming conventions for 
delivered science products are discussed in the IRS Instrument Handbook. 
 
The source spectrum incident on the array is not rectilinear in either the spectral or cross-
dispersed direction. As a result, the Extract module does not extract whole pixels, but rather 
subdivides the array into a network of polygon-shaped sampling elements referred to as “pseudo-
rectangles” that do not necessarily overlap the rectangular pixel grid. These elements allow 
Nyquist sampling of spectra in the dispersion direction. Extraction is performed by calculating the 
signal that falls within the boundary of the “pseudo-rectangles.” The extraction window can be 
visualized with SPICE. Light is assumed to be evenly distributed within a pixel for purposes of 
calculating fractional contribution.   

1.4 Running SPICE in Batch Mode 

SPICE can operate in batch mode instead of on individual BCDs. In this mode, SPICE takes a list 
of BCD-, mask-, and uncertainty-file triplets as input, and it performs identical processing on all 
the files in the list. 

1.4.1 Input 

To extract spectra in Batch mode, begin by selecting Open Batch SPICE generic template from 
the File menu. Next, select from the menu of available batch modes (regular, optimal, extended 
source for hi-res or lo-res). When reading saved templates back into SPICE, the Batch templates 
must be read from the separated Batch option. 

http://irsa.ipac.caltech.edu/data/SPITZER/docs/irs/irsinstrumenthandbook/�
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The parameters available for each module in batch mode are the same as in standard SPICE, but 
the Batch setup is slightly different. An input list of BCD triplets (where a “triplet” is a single 
associated set of data, uncertainty and mask files) must be either read in or created interactively. 
The Batch input list must be a three-column list of image-, bitmask-, and uncertainty-files. The 
list should be comma separated. The full path of each file must be given. 
 
To run the Batch processing, press the single “stack” icon in the setup module; it will run the 
entire SPICE flow for the selected input files. SPICE will display the progress as a percentage of 
the total as processing occurs. 
 
Note: Identical parameters will be used for the extraction of all sources in the Batch List.  

1.4.2 Output 

The output files of the batch processing are saved in subdirectories under the requested output 
file. The directories are numbered from 0 to n-1, in the order that they appear in the batch list. 

1.4.3 New BCD tabs 

When processing is complete, SPICE will offer a View Results button for each of the output 
directories. When viewed, a new tab will be created for that individual BCD. The settings for 
each BCD (for example the detected Ridge percentage) may be reviewed using the squares icon 
on the upper-right of each module window. 
 
SPICE will show the results of Profile, Extract, and either Point Source Tune or Extended Source 
Tune in the plot window. Each input BCD will also be displayed in the FITS window, with the 
Ridge and extraction window overlays. All of the standard visualization tools are available. 
 
Each new tab is also fully operational. The flow can be rewound to any of the modules and rerun 
for just that individual BCD. By default, the rerun outputs will still be directed to the Batch 
subdirectory. However, if Batch is rerun, the new tabs are not automatically updated until View 
Results is selected again.   

1.5 Calibration Files 

The extraction flow requires several calibration files. Default files are provided with the SPICE 
distribution under the irs/cal/ directory. In general, users will not need to change these files. 
Alternate files may be selected within the SPICE GUI using the Calibration Files Edit dialog. The 
calibration files are described below. 
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1.5.1 Wavsamp Files 

Three files describe the “pseudo-rectangles” used to extract from the non-rectilinear spectrum on 
the array: 
 
b[0,1,2,3]_wavsamp.tbl:  Describes the location of the “pseudo-rectangles” in pixel 

coordinates. 
b[0,1,2,3]_wavsamp_wave.fits:  Maps the approximate wavelength for each pixel. 
b[0,1,2,3]_wavsamp_offset.fits:  Maps the approximate spatial offset for each pixel. 
 
The prefix in the filenames, b[0,1,2,3] refers to the short-low (SL), short-high (SH), long-low 
(LL), and long-high (LH) IRS module, respectively (see the IRS Instrument Handbook). 

1.5.2 Default Extraction Widths 

The file containing the default width for point-source extraction from each slit can be found under 
the irs/cal directory: 
 
b[0,2]_psf_fov.tbl: Lists the default width for extraction from each slit. Recall that for the high 

resolution slits (1,3), the extraction is done from the full slit.  

1.5.3 Optimal Extraction Rectified Stellar Templates 

The file containing the rectified stellar template used as the spatial profile for point-source 
optimal extraction from each slit, order, and nod position can be found under the irs/cal directory. 
See §2.5.3 for more information on optimal extraction. 
 
b[0,1,2,3]_rectempl_[1,2][0,1,2].tbl:  Rectified stellar templates for point-source optimal 

extraction. The suffix [1,2][0,1,2].tbl specifies the order and 
nod position (0 = slit center). 

1.5.4 Flux Calibration Tables 

The flux calibration from electrons per second to Janskys is performed based on the parameters 
given in calibration tables. Separate tables are used for point-source (default) or extended-source 
extraction. 
 
b[0,1,2,3]_aploss_fluxcon.tbl:  The correction used in extended-source extraction for light losses 

due to the extraction aperture. 
b[0,1,2,3]_slitloss_fluxcon.tbl:  The correction used in extended-source extraction for light losses 

from the slit due to the changing point spread function as a 
function of the wavelength. 

http://irsa.ipac.caltech.edu/data/SPITZER/docs/irs/irsinstrumenthandbook/�
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b[0,1,2,3]_fluxcon.tbl:  Contains the “tuning” parameters used by the Point Source Tune 
module, incorporating both slit and (in low-res) aperture losses. 

 
These files are located in the cdf/ subdirectory under the spice/ directory. The extracted spectrum 
(Fe) in electrons/sec is converted to Jy (Fν) using the formula Fν = Fe/C where the flux conversion, 
C, is given by: 
 

 

C = y0 × (a0 + a1 × (λ − λ0) + a2 × (λ − λ0)2 + a3 × (λ − λ0)3) 
Equation 1.1   

1.6 BMask Status Bits 

The *bmask.fits files provide status information for each pixel in the input image. During 
extraction, pixels masked as “fatal” do not contribute to the spectrum. By default, the online 
pipeline defines bits 7, 12, 13,and 14 as fatal. In the Extract module, the user can change the 
definition of fatal bitmask conditions using the pull down menu. This change may improve the 
fidelity of features in the final spectrum or, more often, the cosmetic appearance of the 
continuum. 
 
The definition of bit-setting conditions in the *bmask.fits files are given in Table 1.6.1. For a full 
discussion of the bitmask, see Appendix B of this manual and the IRS Instrument Handbook. 
 

Table 1.6.1:  BMask conditions 

Bit #  Condition 
-----  ------------------------------------------------- 
0      (not used) 
1      Latent-image flag 
2      Digital saturation detected in sample(s) along ramp 
3      Radhit detection along ramp in sample(s) along ramp 
4      Non-linearity correction could not be computed in  
       sample(s) along ramp 
5      Data bad (initial dmask; radhit checks this bit) in  
       sample(s) along ramp 
6      Droop or rowdroop removed using questionable value in  
       sample(s) along ramp 
7      Flat field applied using questionable value (flatap) 
8      Flat field could not be applied (flatap) 
9      Stray-light removal or crosstalk correction not applied 
10     Saturated - beyond correctable non-linearity in sample(s)  
       along ramp 
11     Data missing in downlink in sample(s) along ramp 

http://irsa.ipac.caltech.edu/data/SPITZER/docs/irs/irsinstrumenthandbook/�
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12     Only one usable plane 
13     No usable planes 
14     Pixel masked in pmask 
15     (reserved: sign bit)   

1.7 Visualization 

For each flow, SPICE allows visualization of both the input images and the output spectra. Two-
dimensional images are displayed in the FITS window, and one-dimensional spectra and plots in 
the Plot window. The current display in either window can be saved. 

1.7.1 FITS Window 

The FITS window (Figure 1.7.1) displays the input BCD images, which are the two-dimensional 
spectra. The controls at the left of the SPICE window allow the user to zoom in and out. The 
“Base Image” panel in the FITS window allows the user to control the opacity of the image, 
change the stretch and color table, and view the FITS header. The entire panel containing the 
“Base Image” options and all other overlays can be moved with respect to the FITS image itself 
by clicking on the textured edge of it and dragging. This panel can be dragged within the same 
FITS Window, or it can be dragged outside of it (click on the red X to return it to the window). A 
few header keywords (Object Name, Channel number, AORKEY, FOV, CalSet) are displayed at 
the top of the SPICE window when the cursor is in the FITS display (see Figure 1.7.2). 
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Figure 1.7.1: The FITS window, displaying the BCD data file with the spectral trace. 

1.7.1.1 Pixel Values  

SPICE also displays pixel information at the top of the window as the cursor is moved within the 
display. This information includes the RA and Dec corresponding to the sky position of that 
pixel; recall that the spatial direction is approximately parallel to the x-axis in the image. The 
pixel information also includes the approximate wavelength (microns) at that pixel, and it's 
approximate spatial offset from the slit center (arcsec). The pixel information can also be 
accessed by right-clicking the mouse at the pixel of interest to bring up a popup window. Only 
one such window can be accessed at one time.  
 
Note that the RA and Dec displayed in channel 0 (short-low) can refer either to the position 
within the slit or the position on the PeakUp array. The coordinates within Red and Blue Peak Up 
are approximately contiguous on the detector. But they are not contiguous with the RA and Dec 
within the spectral slits. 
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Figure 1.7.2: The BCD and pixel information window 

 

1.7.1.2 Overlays 

SPICE will overlay the ridge line and extraction windows on top of this image when they are 
defined by the corresponding modules. These overlays may be toggled on and off, and their 
colors may be changed. 

1.7.1.3 Saving the Image 

The image and overlays displayed in the FITS window can be saved in a variety of formats from 
the File menu. 

1.7.2 New FITS windows 

Users may find additional FITS display windows useful for examining serendipitous sources 
within the slit. Additional FITS display windows can be opened in two ways:  from the Initialize 
Parameters and Files module once it has been run (choose a Reference Image from the drop-
down menu and click on View), and from the Images menu in the main SPICE toolbar. The 
controls to the left of the SPICE window allow the user to perform a variety of image functions, 
such as zooming in and out, re-centering, and computing the distance between two points. The 
opacity, stretch, and color table can be modified within the Base Image section of the FITS 
window. This section also allows the user to display the FITS header. The entire panel containing 
the Base Image options and all other overlays can be moved with respect to the FITS image itself 
by clicking on the textured edge of it and dragging. This panel can be dragged within the same 
FITS Window, or it can be dragged outside of it (click on the red X to return it to the window). If 
the FITS display window is opened from the Initialize Parameters and Files module, it will show 
the IRS slits. If, in addition, the ridge is set manually, the ridge position will be shown within the 
IRS slit.  

1.7.3 Plot Window 

The plot window displays the results of each module (see Figure 1.7.3). It allows interactive 
changes to the plot ranges. To change the plot range, hold down the Left-mouse button and drag 
the mouse to select the range to be displayed. The box must be dragged from the Upper-Left 
corner to the Lower-Right corner. Dragging up-and-left will return to the original range. 
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A number of options are available in a drop menu by holding down the Right-mouse button over 
the plot: 
 

Properties:  Selection of the plot titles, ranges, and color. 
Save as....:  Save the plot as a .PNG image. 
Print...:  Send the plot to the printer. 
Zoom In/Out:  Zoom one or both of the axes in or out. The "Domain" axis is the X-axis. The 

"Range" axis is the Y-axis. 
Auto Range:  Return to the original axis ranges. 

 
The window includes the option to display the results for Profile, Extract and Tune. The choice is 
made using the arrow (or tab, depending on your operating system) at the top of the plot window. 
The plotted spectra are color coded by order. The Profile display allows interactive selection of 
the Manual Ridge percentage, using the slider at the bottom of the tab. 
 

 

Figure 1.7.3: The Plot Window, showing the results of the Point Source Tune module. The 
displayed output can be changed using the arrow button at the top of the window. 
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Chapter 2. SPICE Modules 

 
The modules available in SPICE are described below. We recommend using the SPICE GUI for 
your reduction and extraction, but if you have a huge number of input BCDs and you are having 
memory issues with the GUI, it is possible to run all of these modules on the command line. 
Please see Appendix A for more information.  
 
Module listing:  
 

• Initialize Parameters and Files 
• Batch Setup 
• Profile  
• Ridge 
• Extract 
• Point Source Tune 
• Extended Source Tune.. 

2.1 Initialize Parameters and Files 

PURPOSE 
 

In this dialog panel, the user assigns input filenames to: image, mask and uncertainty files. 
The output directory is also defined. All are required inputs. 
 
Based on the selected input image file, SPICE will automatically assign default filenames for 
the calibration and output files. These may be modified and/or viewed by clicking on the 
associated EDIT button at the bottom of the panel. 

 
 
INPUTS 
 

Image File:  Select a FITS image file to be processed through SPICE. 
 
Mask File: Select a FITS mask file associated with the image file selected. Note that the 
mask file must be integer data, not floating point. SPICE will attempt to automatically select 
this file for you (see note below). 
 
Uncertainty File: Select a FITS uncertainty file associated with the image file selected. 
SPICE will attempt to automatically select this file for you (see note below).  
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Current Output Directory: Select directory for all outputs to be written. SPICE will create 
the output directory if it does not exist. 

 
Calibration Files: Calibration file selections are viewed and/or modified by clicking on the 
EDIT button. SPICE will display default filenames and will allow the user to modify them. If 
modified, the "default" label on the main panel will be replaced with "custom". 
 
Output Files: Output filenames are viewed and/or modified by clicking on the Edit button. If 
modified, the panel will indicate user specific selection by replacing the "default" label with 
"custom". 

 
Note: SPICE will attempt to find the corresponding mask and uncertainty files within the 
input directory based on a 'best match' algorithm plus appropriate suffix based on the image 
filename. The user may override these selected files. The 'best match' algorithm may find 
more than one file. SPICE will indicated this in the box next to: "# of Best Match Mask Files" 
and "# of Best Match Uncertainty Files" The user is responsible for ensuring that the correct 
files were selected. 

 
 
OUTPUTS 
 

When an input image is selected, it will be displayed in the FITS window. 
 
 
DISCUSSION 
 

SPICE will automatically assign default parameter values in the processing flow based on the 
channel and calibration version information contained in the input image header.   

2.2 Batch Setup 

PURPOSE 
 

In this dialog panel, the user assigns input filenames to a list for Batch processing. The input 
list consists of triplets of: image, mask and uncertainty files. The list may be created 
interactively or read from a file. The output directory is also defined. All are required inputs. 
Based on the selected input image file, SPICE will automatically assign default filenames for 
the calibration and output files. 

 
INPUTS 
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Current Output Directory: Select directory for all outputs to be written. SPICE will create 
the output directory if it does not exist. 
 
Image File: Select a FITS image file to added to the Batch List. 
 
Mask File: Select a FITS mask file associated with the image file selected. Note that the 
mask must be integer data, not floating point. SPICE will attempt to automatically select this 
file for you (see second note below). 

 
Uncertainty File: Select a FITS uncertainty file associated with the image file selected. 
SPICE will attempt to automatically select this file for you (see second note below). 

 
Batch List: The list of input triplets (image, mask, uncertainty) is displayed in the Batch List 
window (see Discussion below for the required format). Each filename separated by commas. 
The available list operations are: 
 

Remove: Removes the selected triplet from the list. 
 
Remove all: Clears the list.  
 
Read from file: The Batch List can be read from a file instead of being created 
interactively. It must have the correct Batch List format. 
 
Write to file: Writes the current Batch List to a file that can be read into later Batch 
processing flows. 

 
Note: Identical parameters will be used for the extraction of all sources in the Batch List. The 
user should be careful when mixing BCDs in different channels. 
 
Note: SPICE will attempt to find the corresponding mask and uncertainty files within the 
input directory based on a 'best match' algorithm plus appropriate suffix based on the image 
filename. The user may override these selected files. The 'best match' algorithm may find 
more than one file. SPICE will indicated this in the box next to: "# of Best Match Mask Files" 
and "# of Best Match Uncertainty Files" The user is responsible for ensuring that the correct 
files were selected. 
 

 
OUTPUTS 
 

When this module is run, the entire batch processing is executed. See §1.4: Running SPICE 
in Batch Mode for a full discussion. 
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DISCUSSION 
 

SPICE will automatically assign default parameter values in the processing flow based on the 
channel and calibration version information contained in the input image header. 

  
Batch List Format: The Batch List must be a three-column list of image-, bitmask-, and 
uncertainty-files. The list should be comma separated. The full path of each file must be 
given.   
 

2.3 Profile 

PURPOSE 
 

This module is the first executable module of SPICE extraction flow, and it must be executed 
prior to the Ridge module. It will compute and plot the mean spatial flux profile across all 
user-selected orders in the same slit. The wavsamp.tbl calibration file is used to specify the 
location of the selected orders. 

 
 
INPUTS 
 

(High or Low) Res Order: SPICE will assign default orders to be used in measuring the 
spatial profile. The module input will be labeled either High Res Order or Low Res Order 
depending upon the information in the BCD FITS header. In High Res (channels 1 and 3), all 
orders (11 - 20) are used by default. In Low Res (channels 0 and 2), the default order depends 
upon the commanded field of view (e.g. an observation in LL-2 will default to orders 2 & 3). 
Alternately, the orders to be used by Profile may be chosen by the user from the pulldown 
menu (in High Res, use the Select Orders option in the pulldown menu to activate the 
checkbox list of orders. The checkbox list can be accessed via the right-hand arrow). 

 
 
OUTPUTS 
 

Profile Output Table (*.profile.tbl): The output of Profile is a table of the wavelength-
collapsed average spatial profile for the selected orders in the same slit. It can be viewed as 
an ASCII table by clicking the View button. The graph of flux vs. spatial position (percent 
across the detector from x = 0) is shown in the plot window. 

 
 
DISCUSSION 
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This module computes a wavelength-collapsed average spatial profile of all orders in the 
cross-dispersed IRS image. It takes the mean of all orders at a given spatial position and 
produces a table of the average flux distribution and the corresponding standard deviation for 
each of N positions across the orders. It uses the wavsamp.tbl file to specify the location of 
the orders. 
 
The Profile module takes as input the two-dimensional Level 1 Basic Calibrated Data (BCD) 
dispersed image in FITS format. This module does not consider the pixel status mask 
associated with the BCD file. The module averages the spatial profile over all selected 
spectral orders. By default, all orders are used. 
 
The input wavsamp.tbl file specifies the location of the spectral orders on the array in x-y 
coordinates. It consists of "pseudo-rectangles" which describe the fractional pixels that 
comprise each wavelength in the spectrum (see Figure 2.3.1). These pseudo-rectangles are 
specified by their four vertices. Each line of the wavsamp.tbl file consists of an order number, 
coordinates of the center of the pseudo-rectangle (x center, y center), wavelength, tilt angle, 
and four vertices (x0, y0, x1, y1, x2, y2, x3, y3). Table 2.3.1 shows an example of the 
wavsamp.tbl. 

 

Table 2.3.1: Sample wavsamp.tbl file. 

\wavsamp version 5.0 (Thu May 9 10:19:35 PDT 2002)  
\processing time 17:05:26 PST 03/12/2003  
\comment WAVSAMP SL, generated from b0_ordfind.tbl 03/12/03  
\character channelID = 0  
| order |x_center |y_center | wavelength | angle    | x0      | y0      
| x1      | y1      | x2      | y2      | x3      | y3      |  
| int   | real    | real    | real       | real     | real    | real    
| real    | real    | real    | real    | real    | real    |  
       2  60.75172  78.86935      5.27230  -1.880000  76.65864  
78.83240  44.87576  79.87564  44.84472  78.90629  76.62761  77.86305  
       2  60.72052  77.89996      5.30254  -1.880000  76.62761  
77.86305  44.84472  78.90629  44.81336  77.93686  76.59624  76.89362  
       2  60.68900  76.93050      5.33278  -1.880000  76.59624  
76.89362  44.81336  77.93686  44.78167  76.96736  76.56455  75.92412  
       2  60.65714  75.96097      5.36303  -1.880000  76.56455  
75.92412  44.78167  76.96736  44.74964  75.99780  76.53253  74.95456  
       2  60.62495  74.99137      5.39327  -1.880000  76.53253  
74.95456  44.74964  75.99780  44.71729  75.02817  76.50017  73.98493  
       2  60.59243  74.02171      5.42351  -1.880000  76.50017  
73.98493  44.71729  75.02817  44.68461  74.05847  76.46749  73.01523 

 
The Profile module divides each pseudorectangle in each order into N_CUTS parts and 
integrates the signal within each part (100 parts in the lights-out pipeline; 1000 parts in 
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SPICE). The integral is divided by the area of each part to yield the average signal at that 
wavelength. A running sum is kept as this procedure is repeated for each wavelength in each 
of the orders to be considered. The standard deviations are calculated from the signal and the 
square of the signal. 

 
NOTE: The profile is calculated as a function of left-to-right percentage along the 
spatial direction of the slit. 
 
The output of Profile is a table describing the average signal and sigma in each of the 
N_CUTS sub-rectangles. The default name of this file is profile.tbl. Figure 2.3.2 shows an 
example of the profile calculated from a SL observation of a faint source on a complex 
background. An excerpt from a profile.tbl table for the same module is shown in Table 2.3.2. 
 

Table 2.3.2: Sample profile.tbl file (excerpt). 

\int CHNLNUM = 0  
\int FOVID = 27  
\int ORDER1 = 1  
| pct  | dn        | stdev     | n   | region |  
| real | real      | real      | int | int    |  
   0.50  2.5838E+01  4.1910E+01   108        0  
   1.50  3.1066E+01  4.0129E+01   108        0  
   2.50  3.0284E+01  3.7313E+01   109        0  
   3.50  2.8732E+01  2.2572E+01   113        0  
   4.50  2.8311E+01  2.0112E+01   121        0  
   5.50  2.6560E+01  1.8742E+01   129        0 
 

 
 



  SPICE User’s Guide 

 

SPICE Modules 21 Profile 

 

 

 

Figure 2.3.1: One spectral order defined by the wavsamp.tbl file is illustrated, with a 
single pseudo-rectangle highlighted. Order curvature is highly exaggerated here for 
illustration. 

 

 

Figure 2.3.2: An example of the outputof the PROFILE module.   
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2.4 Ridge  

PURPOSE 
 

Ridge uses the output file from the Profile module to find the peak in the spatial profile. The 
peak is represented as a percent value and can be a user-specified input. 

 
 
INPUTS 
 

Percent setting (Default or Manual): If the Default option is chosen, the percent that 
represents the peak flux will be computed by SPICE. If the Manual option is chosen instead, 
the user-input field is activated. 
 
PERCENT: This is the input field for a Manual Ridge location; it is only active if the 
Manual option is selected. The user may enter the peak of interest directly or use the slider 
bar on the Profile plot to determine the exact value. The peak is defined in a percent across 
the slit from x = 0. 
 

 
OUTPUTS 
 

Ridge Output Table (*.ridge.tbl): A table containing the x,y position of the peak for each 
order and each wavelength is output. This output table will become the input table for the 
next module, Extract. An overlay appears on the input image. An ASCII version of the file is 
seen by clicking the View button. The spatial position (percent) of the Ridge is drawn on the 
Profile plot.  
 
Ridge Overlay (*.overlay.tbl): A table containing the order, wavelength, and x,y pixel 
positions of the trace determined by the module, together with the x,y pixel positions of the 
extraction aperture defined by the current settings of the Extract module. This file is updated 
if the extraction aperture is changed later. The overlay is plotted on top of the BCD image in 
the FITS window. An ASCII version of the file is seen by clicking the View button. 

 
 
DISCUSSION 
 

The Ridge module defines the spectral trace of the source to be extracted. The module takes 
as input the output of the Profile module, *profile.tbl, and two calibration files, the 
wavsamp.tbl file, and the fov.tbl file. It can either search for the location of the peak, or can 
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be given a manual position. In either case, it produces an output file describing the computed 
ridge line. SPICE also produces a file that gives the pixel position of the ridge line and 
extraction window for overlaying on the BCD image. 
 
If a manual ridge position is specified (as a percentage along the slit), then that value is used 
to create the output file. Otherwise, the Ridge module searches for the peak in the input 
*profile.tbl file. The search is performed within PCT_RANGE of the position expected based 
upon the FOV. In SPICE and the pipeline, PCT_RANGE = 25%. The search algorithm is as 
follows: 
 
For each region R as specified in the profile table file: 
 

• Read in the data for region R: yorig 
• Calculate a linear fit to yorig, and subtract it from the data to obtain yh 
• Perform median filtering of this flattened yh data, using MEDIAN_PTS points to get 

yf. In both SPICE and the pipeline, MEDIAN_PTS = 5. 
• Calculate the new mean, μf, and sigma, σf, for the median-filtered data yf 
• Find the max peak value μh of the not filtered, flattened data, yh 
• Region R has a candidate peak if 

 

mh ≥ µ f + NUM _ SIGMA  

 

σ f  
In both SPICE and the pipeline, NUM_SIGMA = 3.0. 

 
The final cut percentage P is then set to the maximum of the candidate peaks from all the 
regions. But if no candidate peaks were found, P is set to the expected position of the field of 
view as defined by the DFRAC column of the fov.tbl file. 
 
Once the peak is determined, the Ridge module computes the ridge line, defined to be the two 
or more vertices which comprise the group of line segments located at the percentage P from 
the leftmost edge of the pseudo-rectangles. It outputs a table containing most of the 
wavsamp.tbl data, plus the newly computed ridge line.   

2.5 Extract 

PURPOSE 
 

The Extract module performs spectral extraction within a user-specified window. The 
resulting one-dimensional spectrum is in units of electrons per second and will be used as 
input to the flux conversion modules, Point Source Tune and Extended Source Tune. 
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Exract can be used in three separate modes: Regular, Optimal, and Extended. Each is offered 
in its own Generic Template, but the user can switch between them by changing the 
appropriate settings. 

 
 
INPUTS 
 

Optimal or Regular Extract: This menu allows the choice between standard (point or 
extended source) or optimal extraction. 
 
NaNs: SPICE can optionally interpolate over NaN pixels in the data. Choose Replace NaNs 
to perform the interpolation, otherwise choose Do not replace NaNs. NaNs can be present in 
IRS BCDs when there is no good data available for that pixel. 

 
Uncertainty (Constant or File; Optimal Only): During optimal extraction, each pixel in the 
aperture is weighted by the Signal-to-Noise squared. By default, the input uncertainty file 
(supplied in Initialize Parameters and Files module) are used for as the Noise. To keep the 
default, retain the UseFile choice in the pulldown menu. Alternately, by choosing 
SetConstant, the user can enter a constant uncertainty value (in electrons per second) giving a 
purely profile-weighted extraction. This option is appropriate for sources that are fainter than 
the background and where background noise dominates, or where the input file has poor 
uncertainty estimates. The output uncertainties will reflect whatever constant is entered rather 
than the true uncertainty. 
 
Constant Uncertainty: The user-specified constant uncertainty for profile-weighted 
extraction. This field is only active if SetConstant is chosen for the type of uncertainty in 
optimal extraction. 
 
Set Fatal Bit Pattern: The BMask defines the status of each pixel using bitwise encoding. 
Pixels in which fatal bits are set will be excluded from the extraction. The fatal bits can be 
defined by the user by choosing Select Bits and using the checkbox menu to the right; 
otherwise, retain the Default. See §1.6 for a list of bit definitions.  
 
PS or ExtSrc: Choose Point Source – Default, Point Source - Manual, or Extended Source - 
Full (28 pixels) to define the width of the low-resolution extraction aperture. In the high-
resolution slits, this module extracts a 1D spectrum from the full slit. In the low-resolution 
slits, the spectrum is extracted along the Ridge location in accordance with the wavelength-
dependent Point Spread Function (PSF) and the spectral trace. The Extract module can 
employ a window with a different width, but the width will still scale with wavelength. 
Alternately, an extraction window with constant width may be used by specifying λ = 0 for 
the reference wavelength. 
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Note: The only properly calibrated, non-point-source width extraction is the extended source 
28 pixel width. Flux conversion factors are based on standard width extractions, as defined by 
the psf_fov.tbl files. Non-standard extractions will still be converted from electrons per 
second to Janskys, but the conversion factors will be incorrect. 
 
Note: A very wide manual window can potentially cause the extraction of pixels between the 
orders, or even in a different order. Inter-order pixels will be masked if bit #8 is set as fatal 
and Spitzer BMasks are used. To check the fatal bits, use the Select Bits option in Set Fatal 
Bit Pattern (see above). Be sure to visually inspect the extraction window overlay to avoid 
including pixels from a different order. 
 
Width (pixels): The width of the extraction aperture (at the reference wavelength) in pixels. 
This field is only active for user input if the Manual point source extraction option is chosen. 
 
Wavelength (um): The reference wavelength for the extraction aperture (set to zero for a 
constant, non-expanding width). 
 

 
OUTPUTS 
 

Spectrum (*.extract.tbl): The output of the module is the one-dimensional extracted 
spectrum, in units of electrons per second. The spectrum is written to the table in the output 
directory and displayed in the plot window. An ASCII version of the file is seen by clicking 
the View button. 
 
Rectified products (Optimal only): If optimal extraction is used, additional products are 
output. They are the rectified version of the 2D spectrum, uncertainty, BMask, and spatial 
offset files. The rectified versions are named: *.rectified_flux.fits, *.rectified_unc.fits, 
*.rectified_bmask.fits, *.rectified_offset.fits. 

 
 
DISCUSSION 
 

Settings: The Extract module can be used in three separate modes. Usually the choice of 
mode will be made at the beginning when choosing a Generic Template for the flow. It may 
occasionally be convenient to switch modes mid-stream. To do so, each mode requires setting 
the parameters to appropriate values: 
 

Regular: Set Optimal or Regular Extract to Regular; set PS or ExtSrc to one of the 
point source options. Other parameters may be modified if necessary. Make sure  the 
Point Source Tune module is enabled. 
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Optimal: Set Optimal or Regular Extract to Optimal; choose whether to modify the 
uncertainty weighting (see above); set PS or ExtSrc to one of the point source 
options. Other parameters may be modified if necessary. Make sure the Point Source 
Tune module is enabled. 
 
Extended: Set Optimal or Regular Extract to Regular; set PS or ExtSrc to the 
Extended Source option. Other parameters may be modified if necessary. Make sure 
the Extended Source Tune module is enabled. 

 
Only one tuning module should be enabled. To disable a module, use the "X" button in the 
upper-right corner of the module box. To enable a module, click the "Enable" button. 

2.5.1 Standard Spectrum Extraction 

The Extract module takes the dispersed BCD image and extracts the 1-D spectrum along the trace 
defined by ridge.tbl. The module takes as input the data array, bcd.fits and the associated 
uncertainty plane and pixel status bitmask; it also takes the output of Ridge, which defines where 
the extraction is to be performed. 
 
In the high-resolution slits, this module extracts a 1D spectrum from the full slit. In the low-
resolution slits, the spectrum is extracted along the Ridge location in accordance with the 
wavelength-dependent Point Spread Function (PSF) and the spectral trace. The width of the 
extraction is defined in the psf_fov.tbl file, which gives the width to employ at a fiducial 
wavelength for each order. The width of the extraction scales with wavelength in all low 
resolution slits, under the assumption that the spectrum is diffraction limited. However, the width 
does not scale between sub-slits. Rather, the extraction width has been empirically determined for 
each subslit, and wavelength scaling is performed within each individually. The exception to the 
wavelength dependent window width in low resolution is the case of observations taken in the 
"Both" fields of view; that is Long-Low-Both or Short-Low-Both. In that case, the default is to 
perform a full slit extraction. Also, the user may demand a non-scaling width by setting the 
reference wavelength to 0 when selecting a manual extraction width. 
 
The source spectrum incident on the array is not rectilinear in either the spectral or cross-
dispersed direction. As a result, the Extract module does not extract whole pixels, but rather 
subdivides the array into a network of polygon-shaped sampling elements referred to as “pseudo-
pixels” (see Figure 2.5.1), which lie within the “pseudo-rectangle” that defines each wavelength 
in each order (specified in the wavsamp.tbl file). Pseudo-pixels do not necessarily overlap the 
rectangular pixel grid. These elements allow Nyquist sampling of spectra in the dispersion 
direction. Extraction is performed by calculating the signal that falls within the boundary of the 
“pseudo-rectangles” which lie within the extraction window. Light is assumed to be evenly 
distributed within a pixel for purposes of calculating fractional contribution. 
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Figure 2.5.1: (Left) A pseudorectangle is divided into pseudopixels. The pixels form the 
FITS image for a rectangular grid, as illustrated in the upper left corner. (Right) A 
pseudopixel is shown against the pixels of the original FITS image. The pseudo pixel 
contains partial FITS pixels, so each partial pixel must be carefully accounted for to 
perform the extraction. 

The input pixel-status bitmask is used to define "fatal" bit-flags to identify pixels that will be 
excluded from the average of the pseudo-rectangle. The extraction depends on the processing 
version and the module:  

• For S18.7, for SL, LL and LH data, the extraction is the sum of signal in the non-flagged 
pixels at each wavelength divided by the height  (measured along the spectrum in pixels) of 
the extraction window, as set by the wavsamp wavelength calibration file. For SH, the 
extraction is the sum of signal in the non-flagged pixels at each wavelength divided by the 
number of (fractional) pixels; 
 

• For S18, only LH spectra were divided by the wavsamp height; 
 

• For previous processing versions, no modules had spectra divided by wavsamp height – all 
were simply the sum of the signal in the non-flagged pixels at each wavelength, divided by 
the number of (fractional) pixels.  

Note that unflagged bad-pixels (NaN or zero DN) are not included in the calculation of the value 
of the extracted flux. Alternately, the NaNs may be interpolated over and included, by selecting 
that option in the module input switches. 
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The uncertainty defined in the input uncertainty plane is propagated into the extracted output 
spectrum. The output spectrum table includes the order, wavelength, flux (in electrons per 
second), propagated error, and cumulative pixel status for each wavelength. The cumulative pixel 
flag is a bit-wise OR of the flags of contributing pixels. 

2.5.2 Extended Source Extraction 

In addition to the standard point source extraction, the Extract module in SPICE offers the users 
the ability to estimate the surface flux for particular extended sources. 
 
The calibration assumes that the source is infinitely large in the sky, and that at each wavelength 
the source is uniform. Starting from the extracted spectra, two corrections are applied: one for 
light losses due to the extraction aperture, and another for light coming in and out of the slit due 
to diffraction. We describe each in turn here. A more formal discussion is provided in the IRS 
Instrument Handbook. 
 
In the calibration of point sources, SPICE uses an expanding aperture for the low-resolution 
modules, and the full slit for the high-resolution ones. For extended sources, a straight-edged 28-
pixel extraction aperture is used for the low-resolution modules (which allow us to ignore the 
noisy edge pixels). The full slit is used for the high-resolution modules. Appropriate calibration 
coefficients (“fluxcon values”; see §1.5) are applied to the low-res modules to account for the 
large extraction window and are provided in b[0,2]_aploss_fluxcon.tbl. These fluxcon values 
assume a point source centered on the slit. For a point source, the difference in e-/s between the 
point and extended source apertures is at most ~10%. When the user clicks the extended source 
button, the fluxcon table for the large aperture is applied to convert from e-/s to Jy. Note that no 
such correction is necessary for the high-resolution modules -- they will have the same fluxcon 
table for the point source and extended source calibrations. 
 
The slit losses are a function of wavelength. For point sources, the flux lost due to the PSF wings 
outside the slit is added back by comparing the signal to a model. For a source that is uniform in 
flux at a given wavelength and infinitely large, the light lost from the slit is exactly matched by 
the light gained by the slit. Because the point source calibration adds the flux from the wings 
outside the slit in order to derive the final calibration, this calibration must be "undone". To 
understand the wavelength dependent loss of light, the point spread function was simulated using 
a STinyTim model with the slit sizes quoted in the IRS Instrument Handbook. The slitloss 
correction was taken to be the ratio of the flux within the slit of a simulated PSF, to the total PSF 
flux. The slitloss corrections are given in (b[0,1,2,3]_slitloss_convert.tbl), which have the 
wavelength dependent factor by which the spectrum of the extended source should be multiplied. 
 
To convert the resulting spectrum in Jy to a surface brightness, the user should divide it by the 
area of the aperture in the sky (or the area of the extraction window, if the default was not used): 
 

http://irsa.ipac.caltech.edu/data/SPITZER/docs/irs/irsinstrumenthandbook/�
http://irsa.ipac.caltech.edu/data/SPITZER/docs/irs/irsinstrumenthandbook/�
http://irsa.ipac.caltech.edu/data/SPITZER/docs/irs/irsinstrumenthandbook/�
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Table 2.5.1: Slit dimensions for the IRS modules 

Module name     Slit Length    Slit Width     Solid angle 
       (arcsec)    (arcsec)       (arcsec^2) 
-----------     -----------     ----------     ------------ 
 
SL2             50.4    3.6         181.44 
SL1             50.4    3.7         186.48 
LL2             142.8    10.5   1499.40 
LL1             142.8    10.7   1527.96 
SH              4.7    11.3   53.11 
LH              11.1    22.3   247.53 

 
 
After this process, it is likely that the spectra from different modules will not match each other. 
Most extended astronomical sources have spatial and spectral structure that cannot be accounted 
for a-priori by any calibration set. It is recommended that the users compare their data to other 
photometric measurements (like MIPS-24 data) to achieve better calibration. Note that IRAC 
channels 3 and 4 need post-pipeline processing to be usable for extended emission (see the IRAC 
Instrument Handbook). 

2.5.3 Optimal Extraction 

In the Extract module, the user has the option to select profile-weighted and signal-to-noise 
weighted “Optimal” extraction. This option can be selected in the pulldown menu under the 
Extract module. The default is “Regular” unweighted extraction. The name of the output file is 
the same, regardless of which option is chosen. Optimally extracted spectra may be identified by 
the information in the table header. 
 
The “Optimal” algorithm yields a minimal-noise, unbiased flux estimate in each wavelength bin 
(Horne, 1986), by weighting the extraction by the object profile and the signal-to-noise of each 
pixel. Specficially, the flux density (electrons per second) in a wavelength bin, F, is given by: 
   

 

F =
WiFi /Pi∑

Wi∑
, 

Equation 2.1 

 
 
where Wi is the weight, 

 

Wi = (Pi /σ i)
2 

http://irsa.ipac.caltech.edu/data/SPITZER/docs/irac/iracinstrumenthandbook/�
http://irsa.ipac.caltech.edu/data/SPITZER/docs/irac/iracinstrumenthandbook/�
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Equation 2.2 

 
Fi is the flux, Pi is the stellar profile template, and σi is the uncertainty in the ith pixel.  
 
This extraction is accomplished as follows by the Optimal Extract module. First, the dispersed 
image of the source is divided by the dispersed image of a standard stellar point source. At each 
wavelength, the flux of the standard template is normalized to unity, and the peak is shifted to the 
center of the extraction window. Next, each pixel in the aperture is weighted by the Signal/Noise 
squared, and the weighted average flux is computed. 
 
By default, the input uncertainty file (supplied in the SPICE Initialize Parameters and Files 
module) and a standard point-source profile are used to compute the weights and output 
uncertainties. Alternatively, the user can enter a constant uncertainty value (in electrons per 
second) giving a purely profile-weighted extraction. This option is appropriate for sources that are 
fainter than the background and where background noise dominates, or if the uncertainty file is 
noisy. The output uncertainties will reflect whatever constant is entered rather than the true 
uncertainty. 
 
To facilitate alignment of the source to the standard profile, optimal extraction is performed in 
rectified space. The curved BCD image is straightened using the wavsamp.tbl calibration file. 
Because the Spitzer PSF is under-sampled by IRS pixels and the spectral trace does not follow 
columns exactly, diagonal stripes are visible in rectified spectral images. Each order is rebinned 
during rectification to 1001 pixels in the spatial direction to increase the accuracy of the 
rectification and avoid pixelization error at the edges of the aperture. Unweighted extractions in 
rectified space match regular extraction to better than 1%. 
 
Rectified flux, uncertainty, and BMask products are written out, allowing the user to inspect the 
spatial profile of the source or construct custom profile templates. These files are by default given 
names ending with .rectified_[flux,bmask,unc].fits. The wavelength and spatial scale of the 
rectified image is described by the wavsamp.tbl file for the appropriate order. In that table, each 
row describes the extraction ``pseudo-rectangle'' for each extracted wavelength. In the rectified 
image, the rows in each order correspond to rows in the wavsamp.tbl for that order, and the row 
wavelength is given explicitly in the table. The orientation of each order in the rectified image is 
the same as in the BCD image (e.g. for SL-1 the blue end is at the top of the dispersed image and 
the red end is at the bottom). The spatial scale of each row is slightly complicated to calculate. It 
is given by the length of the pseudo rectangle (described by X0, Y0, X1, Y1, X2, Y2, X3, Y3), 
multiplied by the plate scale of the module (e.g. 1.8 arcsec/pix for SL) and then divided by 1001 
(the number of columns in the rectified order). The rectified_offsets.fits files give the spatial 
offset for each pixel in the rectified image. 
 
The rectified stellar templates used for point-source profiles are provided in the SPICE cal/ 
directory, one for each channel, order, and standard nod position (including nod 1, nod 2, and slit 
center) with filenames like: 
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b[channel]_rectempl_[order][nod].fits 
 
These were constructed with Spitzer IRS observations of the flux calibration standards HR 7341 
(1 Jy at 12 microns; SL and LL) and Xi Draconis (11 Jy at 12 microns; SH and LH). SPICE will 
automatically select the appropriate profile template for the channel and order using the BCD 
header FOVID keyword. The template closest to the selected ridge location will be used. Sources 
in the non-commanded order can be extracted using the “Orders” pulldown menu under the 
PROFILE module. 
 
Optimal extraction provides greater improvement (over regular extraction) for low S/N data. 
Figure 2.5.2 shows the gain in optimal S/N vs. S/N in the regular extraction. Gains in S/N up to a 
factor of 2 have been achieved for sources with S/N ~ 3, corresponding to an effective 
quadrupling of the exposure time. There are diminishing returns for sources with S/N > 30. 
Comparable gains in S/N have been achieved by narrowing the extraction aperture to about 3 
pixels and performing a regular extraction. However, the latter method requires custom flux 
calibration, and is still sub-optimal, in principle. 
 
No special steps are required prior to optimal extraction; run Profile then Ridge, as you would 
before regular extraction. Note that optimal extraction is more sensitive to the Ridge location than 
regular extraction. For faint sources where the profile is noisy, the Ridge percentage can be 
refined manually until the best result is obtained. Optimal extraction may be performed in Batch 
mode by first selecting Optimal in the Type pulldown menu under the Extract tab. After optimal 
extraction, use the Point Source Tune module to create a properly calibrated spectrum. (For 
nonstandard apertures, custom flux calibrations may be necessary.) 
 
Optimal extraction works best for point sources observed in IRS Staring mode, at the standard 
nod positions (33%, 66%) or at the center position (50%). For sources observed at non-standard 
locations along the slit, Optimal Extract will choose the closest stellar template, in terms of Ridge 
percentage. However, low-frequency sinusoidal wiggles may appear in optimally extracted 
spectra if there is a mismatch with the stellar template. 
 
The user can create custom rectified stellar template (rectempl) by Optimal extraction of a bright 
star observed at the same Ridge percentage as the science target. The rectified 2D stellar spectrum 
is output as a standard Optimal extraction product. 
 
Optimal extraction of extended sources has not been tested. If a standard point source profile is 
used, the center of the object will be weighted more than the outskirts. An extended source profile 
could be constructed and used, but it must incorporate pixelization effects, and must have an S/N 
greater than that of the spectrum to be extracted in order to achieve any gain. Do not use 
Extended Source flux calibration for optimally extracted spectra. The Extended Source Tune 
function assumes the science target uniformly fills the slit, whereas Optimal extraction assumes a 
point-source cross-dispersion profile. 
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Figure 2.5.2: Gain factor for Optimal extraction over Regular extraction as a function of 
Regular Signal/Noise for standard extraction apertures, derived from SL and LL 
observations. Diminishing gains are obtained for bright sources with S/N > 30. Maximal 
gains of > 2 are possible for faint sources with S/N < 5. The lowest S/N considered for 
Regular extraction is S/N = 1.5.   

2.6 Point Source Tune 

PURPOSE 
 

The Point Source Tune module converts the extracted spectrum from units of electrons per 
second to flux density (Jy). This module is for point source extractions. Extended Source 
Tune is used for extended sources. The conversion is only valid for the standard extraction 
width. 

 
 
INPUTS 
 

There are no user inputs for Point Source Tune. 
 
 
OUTPUTS 
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Flux-calibrated spectrum (*.spect.tbl): The output of the module is the flux calibrated 
spectrum. It is written to the output table and displayed in the plot window. An ASCII version 
of the file is seen by clicking the View button. 

 
 
DISCUSSION 
 

This module applies absolute flux calibration to the one-dimensional spectral output file from 
Extract. For each separate spectral order in SL and LL and each Echelle order in SH and LH, 
Point Source Tune applies adjustments to the shape of the order and corrects by a scaling 
constant, in units of electrons/s/Jy, to convert the spectrum to units of Jy. The scaling and 
shape adjustments are contained in an input calibration file, fluxcon.tbl. This file contains the 
coefficients calculated by fitting an nth-order polynomial, where 1 ≤ n ≤ 5, to the Extract 
output of one or more calibration stars so that their observed IRS spectra are forced to match 
a model spectrum taken as truth. The ASCII output from Point Source Tune contains five 
columns containing the order number, wavelength in microns, flux in units of Jy, uncertainty 
in the flux measurement in Jy (currently not suited to derive signal-to-noise ratios), and any 
needed flags.   

2.7 Extended Source Tune 

PURPOSE 
 

The Extended Source Tune module converts the extracted spectrum of extended sources from 
units of electrons per second to flux density (Jy). Point Source Tune is used for point sources. 
The calibration assumes that the flux is measured over a 28-pixel straight edge aperture in the 
low-res modules and over the full slit in the high-res ones. These are the default parameters of 
the Extract module with Extended Source extraction. The resulting calibration is only strictly 
valid for cases in which the extended source is uniformly bright and covers an area much 
larger than the slit. In practice, the calibration will be approximately correct for sources that 
are uniform over the width of the slit plus several PSF widths (~6 pixels) on either side. 

 
 
INPUTS 
 

There are no user inputs for Extended Source Tune. 
 
 
OUTPUTS 
 

ReTune Results (*.aploss_spect.tbl, *.extsrc.tbl): The output of the module is two spectra. 
The first (aploss_spect.tbl) is the flux tuned spectrum (in Jy). The spectrum is derived 



  SPICE User’s Guide 

 

SPICE Modules 34 Extended Source Tune 

 

 

assuming a point source extracted with the full aperture (aploss correction). The second 
(extsrc.tbl) is the spectrum in aploss_spect.tbl multiplied by the slit loss correction (slitloss 
correction). The slitloss correction assumes that at a given wavelength the source is infinite in 
extent and it has a constant surface brightness. In practice, the correction should be valid for 
sources that are uniform over an area slightly larger than the slit (by a few PSF widths). Both 
spectra are written to the output directory, and the second one is displayed in the plot 
window. 

 
 
DISCUSSION 
 

The module applies photometric “tuning” and flux conversion coefficients to the extracted 
full slit 1-D spectrum from Extract, and converts it to Jy. The module corrects the slope and 
curvature of each order and takes into account the effects of the extended source extraction. 
This is done in two steps. First, the flux calibration appropriate for the large aperture is 
applied (producing aploss_spect.tbl). Secondly, the module applies the correction for slit 
losses (producing extsrc.tbl). See extended source extraction for more details. 
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Chapter 3. SPICE Menus 

3.1 File Menu 

Open SPICE Generic Template: Create a new processing flow for a single BCD. 
 
Open Batch SPICE Generic Template: Create a new batch processing flow. 
 
Read SPICE User-Saved Template: Restore a processing flow from a previous saved template 
 
Read Batch SPICE User-Saved Template: Restore a processing flow from a previous batch 
saved template 
 
Save... Save processing flow to a known template file 
 
Save As... Save processing flow to a new template file 
 
Save Current Plotted Image as FITS file: This will allow you to save the currently plotted 
image as a FITS file. No overlay information is saved. 
 
Save Current Plotted Image & Overlays to JPEG, GIF, BMP, or PNG: This will allow you to 
save the currently plotted image, along with the overlays, to a JPEG, GIF, BMP or PNG file. 

3.2 Edit Menu 

Undo [ctrl-Z]: Undo the last command 

3.3 Process Menu 

Run: run the entire processing flow. 
 
Step: Run only one processing step. 
 
Reset Run: reset all parameters 
 
Pause Run: pause the processing at the current step. Allow for restart. 
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3.4 Tools Menu 

Memory Monitor: This dialog shows how much memory (bytes) JAVA has allocated (total 
memory) and how much of that allocation is currently available (free memory). We are using this 
mainly as a debugging tool to determine when JAVA is having trouble with the memory 
allocation, mainly on Sun Workstations. 

3.5 Images Menu 

The Images menu allows you to load and display a FITS format sky image from a variety of 
different sources. The new image will be opened in a stand-alone FITS tab. The available image 
sources are: 
 
ISSA: IRAS Sky Survey Atlas -- 12, 25, 60 100 micron IRAS images 
 
2MASS: Two Micron All Sky Survey -- J, H, K images NOTE: These are compressed images, 
not the 2MASS Atlas images that contain all of the original scientific information. Use the 
2MASS catalogs for detailed source information. 
 
MSX: Galactic Plane Survey -- A, C, D, E images 
 
DSS: Digital Sky Survey optical images 
 
Sky View: The image collections from SkyView 
 
NED: NASA/IPAC Extragalactic Database 
 
FITS File: A local FITS image resident on your disk. 
 
All Sky Images: The DIRBE 60 micron or ISSA all sky image can be displayed. 
 
The first time you select an image to display that will be downloaded from a remote server, 
SPICE will ask you to specify a cache directory. SPICE caches the images so that if you want to 
display them again they are available locally from your disk. Select a directory where you can 
store large images. 
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3.6 Overlays Menu 

The Overlays menu allows you to plot different overlays onto images that SPICE is displaying. 
These options are available only for FITS images that are opened in stand-alone FITS tabs. They 
are not available to overlay on IRS spectra BCDs. The available overlays are: 
 
Catalogs from IPAC: From this dialog you can select catalogs to overlay onto your current 
target image. The currently available catalogs are the IRAS Point Source and Faint Source 
Catalogs, the 2MASS Point and Extended Source Catalogs and the NED Catalog. The dialog 
returns a list of targets in a circle of the radius you enter in degrees. 
 
Catalogs from SkyView: From this dialog you can select from a list of catalogs from Skyview to 
overlay onto your current target image. The dialog returns a list of targets in a circle of the radius 
you enter in degrees. 
 
Catalog File: Select a file in IPAC table format that resides on your local disk to overlay. 
 
Crop: Crops the image using a mouse-selected box on the image. 
 
Grid: From this dialog you select the type of grid to overlay onto the image display. 
 
Distance Tool: This function measures the distance between 2 positions on an image. After 
selecting the distance tool, click with the left mouse button at the starting position (position 1) 
and then drag the mouse to the ending position (position 2). SPICE will report the distance in the 
selected units from position 1 to position 2. Click on the options button in the Distance Tool layer 
(the one with red horizontal lines) to see the various distances you have measured, change the 
units or colors, turn lines off/on, etc. 
 
Slice Tool: Draw a line through the image by clicking the left mouse button and dragging the 
mouse along the desired segment. This will open a slice dialog, which will show the information 
about the end positions of the segment and an XY plot of flux vs. position along the segment. The 
plot can be zoomed, saved, and printed. 
 
Area Statistics: Provides simple statistics of the pixels within a selectable area. 
 
Mark object on Plot: Select this option to use the mouse to add marks to your current image. 
The type of mark and optional labels are user-selectable. 
 
Current Fixed Target: Mark the position of the "current target" on the image. The current target 
is defined by the most recent search in the Images Menu, not by the target of the IRS BCD loaded 
for spectral extraction. 
 
Generic Focal Plane: Draw a circle or square, of user-specified size, on the current image. 
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Spectrum: Overlay a spectrum from a table file on the output spectrum in the Plot window (see 
below). Choosing this option opens a dialog box to choose the overlay spectrum and to allow the 
following options: 
 

Redshift of Target/Overlay: Enter the redshift of the target and the overlay spectra. The 
overlay will be shifted into the observed frame of the target spectrum and then overlaid;  
 
Flux Normalization by Constant: The overlay spectrum can be normalized by a 
constant value entered here. All flux values in the overlay spectrum will be multiplied by 
this value; 
 
Flux Normalization by Wavelength: The overlay spectrum can by normalized to ensure 
that its flux value at the chosen wavelength is equal to that of the target spectrum at the 
same wavelength. 
 

The overlay spectrum will be shown as a dotted line. If order information is given in the input 
table, the orders will appear in varied color. Once opened, the overlay spectrum can be toggled to 
display or not using the check boxes in the plot window. NOTE: The overlay spectrum must be 
in IPAC table format. An example is given below.  
 
Line List: Overlay a line list of labeled wavelengths from a table file on the output spectrum in 
the Plot window. The following options are available:  
 

Remove Previous Line Lists: If checked, this option clears previous line lists;   
 
Redshift: The overlay wavelengths are assumed to be in the rest frame. They can be 
redshift to the target redshift entered here. 
 
NOTE: The line list must be in IPAC table format. An example is given below.  

 
 
DISCUSSION 
 
The overlay capability within SPICE provides a flexible interface for choosing the extraction 
window and browsing the results. 
 
IRS Focal Place Overlay: SPICE has the option to overlay the IRS slit position on a FITS 
Image. This option allows for easy interpretation of source positions either for the intended target 
or serendipitous sources that fall within the slit. When the IRS Focal Plane overlay is enabled, the 
position of the slit is drawn and control icons are added to the FITS image window. The FOV 
table icon opens a dialog box, which allows the user to choose which of the available slit overlays 
to enable. 
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In addition, the position on the Image can be matched to the position of the cursor within the 2D 
IRS dispersed image. Clicking on the IRS image within the slit will cause that position to be 
marked by a circle on the FITS image. If multiple images containing the slit position are open, the 
circle will be marked on all of them. Conversely, clicking within the slit on the FITS image will 
measure the percentage along the slit appropriate for input to the manual option of the RIDGE 
module. The percentage can be viewed by displaying the FOV table (the table icon in the box 
labelled "FOV" in the FITS image controls). It can be automatically entered into the RIDGE 
module by choosing "Apply". Note that this option is only available for the active order in low 
resolution; that is, if the Profile module has been run for the default, then only the default order is 
available for Ridge, and to choose the off-target order, Profile must be re-run. 
 
For example, let’s assume that the current module flow is a Long-Low (channel 2) second-order 
spectrum of a known galaxy. The user, however, can see an unknown, faint continuum spectrum 
within the off-target first-order slit. To investigate further, the user can bring up a FITS image of 
the region of sky around the galaxy by using the Images menu. If a Spitzer image is available, it 
can be chosen from the "FITS Image File" option. Otherwise, SPICE can access standard sky 
surveys such as 2MASS. Using the IRS Focal Plane Overlay, the user can overplot both long-low 
slits on the image. Clicking on the unknown spectrum in the 2D IRS dispersed image will circle 
that position on the 2MASS image. To interactively examine the off-target order, the user needs 
to run Profile with first-order selected. Now, clicking on the 2MASS image within the first order 
slit will measure the Ridge percentage. So the user selects the "Manual" option in Ridge, and to 
see the percentage, the user opens the FOV table from the controls next to the 2MASS image. 
Clicking in the first order slit on the new object reveals that it is at 45% along the slit; clicking on 
"Apply" enters this automatically into Ridge. Now, running the rest of the current flow extracts 
the serendipitous object. 
 
Spectrum Overlay: A spectrum used for overlay onto the output plot must be in IPAC table 
format. An example of a valid spectrum is: 

|order     |wavelength     |flux         |error        |bit-flag      | 
|int       |real           |real         |real         |int           | 
|          |               |Jy           |Jy           |              | 
 2          5.12652         0.000513      0.000026      12289   
 2          6.00354         0.044234      0.001196      0  
 2          7.03177         0.125992      0.001067      1    
 2          7.60636         0.303060      0.002753      0  
 3          7.33419         0.141934      0.001965      0 
 

Line List Overlay: Input files for line list overlay must be in IPAC table format, containing a 
column for a label and two columns for wavelength. Wavelengths should be entered as a range, 
instead of a single value. The range will be shaded. An example of a valid line list is: 

|label        |lowerbound         |upperbound          |  
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|char         |real               |real                |  
|             |                   |                    |  
 PAH           3.3                 3.3 
 PAH           6.2                 6.2 
 PAH           7.7                 7.7 
 PAH           8.6                 8.6 
 PAH           11.3                11.3 
 PAH           12.6                12.6 
 PAH           14.2                14.2 
 PAH           16.4                16.4 

3.7 Options Menu 

Use Automatic SPICE Version Update: The default for this is 'yes'. If an update for SPICE is 
available, when you start SPICE and connect to our server you will be asked if you would like to 
update your software. 
 
Cache Prefs: Spot caches to disk images that it retrieves from remote servers so that they are 
available locally the next time you ask Spot to display them. This saves time and network traffic. 
The first time you retrieve an image, Spot will ask you to designate a cache directory. You can 
change the location or size of the disk cache directory from this dialog. 
  

 
 
 
Network Proxy Setup: This dialog allows you to set up a network proxy for SPICE access to the 
servers at the Spitzer Science Center. 
 
Use Large Control Icons: Toggle the size of the control icons on the right of the FITS window. 
 
Visualization: Show Mouse Help: You can remove the mouse control box when displaying 
images if you need more screen real estate. 
 
Visualization: Show Side Bar on Current Frame / Show Side Bar on All Frames: These two 
options allow you to make the side bars, on the right of any image you are displaying, appear or 



  SPICE User’s Guide 

 

SPICE Menus 41 Help Menu 

 

 

disappear. This is useful if you are working on a very small screen and want to examine as much 
of the image as possible. 

3.8 Help Menu 

The Help menu provides access to the SPICE on-line help. 
 
Overview: The on-line help directory is here. 
 
About: The current version of SPICE you have installed 
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Appendix A. SPICE on the Command Line 

A.1 Why use the command-line version of SPICE?  

If you have only a handful of spectra to extract, we suggest that you use the GUI version of 
SPICE. The GUI version provides visualization features (2D spectrum display, profile plots, ridge 
overlays, etc.) which can help you ensure that your extraction is going as desired.  
 
If you have a large number of spectra that must all be reduced in an identical way, one option is 
to use the SPICE GUI in batch mode. However, if you have a huge number of spectra and/or 
limited memory, batch mode may be insufficient to reduce all of your spectra in one batch. In that 
case, you may either choose to run multiple batches, or to use the command-line version of 
SPICE to write a script to reduce your spectra. The command-line version also makes it possible 
to call SPICE from within other programs (e.g. IDL). 
 
If you choose to write a script, we recommend that you first use the GUI on a few of your spectra 
to experiment with your extraction parameters. You can then use the command line to script the 
remainder of your extractions using the same, optimized parameters. Every time the GUI runs, it 
writes out the corresponding command-line parameters in the spice*.log files in your ~/.spot/ 
directory. For each module, the input parameters are listed on separate lines for improved 
readability. To execute these on the command line, you will have to reformat them into one line. 
In addition, you must make sure that the SPICE binaries (in the bin/ subdirectory of your 
installation) are in your path. 

A.2 Running SPICE on the Command Line 

The SPICE modules are run on the command line using the following syntax. We assume that 
you are in the directory containing the data to be reduced.  

unix% <module> <option flag> <specification> 

where the option flags can be used to specify input and output files and parameters, and must be 
matched with a corresponding specification. e.g. to run the PROFILE module on the file 
SPITZER_S0_7130112_0002_6_A14567688_bksub.fits with the corresponding mask files and 
calibration files, you would type the following (long!) one-line command: 

profile -i SPITZER_S0_7130112_0002_6_A14567688_bksub.fits -b 
SPITZER_S0_7130112_0002_6_A14567689_bkmsk.fits -fb 28800 -o 
SPITZER_S0_7130112_0002_6_A14567688_bksub.profile.tbl -q 
SPITZER_S0_7130112_0002_6_A14567688_bksub.profile.qa -t 
/Applications/spice/spice.app/Contents/Resources/platform/mac/cal/C15.0
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PRE25/b0_psf_fov.tbl -w 
/Applications/spice/spice.app/Contents/Resources/platform/mac/cal/C15.0
PRE25/b0_wavsamp.tbl -c 1000 

 
The available modules are listed in the following sections, along with an explanation of their 
option flags.   

A.3 Profile 

To run, type:  

unix% profile <option flag> <specification> 

 
Where the options are as follows:   
    
-i   The name of the input 2D spectrum from which you wish to extract a 1D spectrum.  
 
-b  The mask file associated with the input spectrum.  
 
-fb  Fatal bit pattern for the mask file. Set this to the decimal representation of the fatal bit 

flags. Pixels with the specified flags will be excluded from the SPICE extraction. See 
Appendix B for how to calculate the fatal bit pattern. Default value is 18432. 

 
-o  The name of the output table that will hold the wavelength-collapsed average spatial 

profile for the selected orders. Default value is <input file>.profile.tbl 
 
-q  The name of the output qa file. Default value is <input file>.profile.qa. This file tells you 

six things about the profile: 
• profMaxFlux - max value of dn for all cuts  
• profLocMaxFlux - location (%) of max dn cut 
• profMaxStdev - max value of stdev for all cuts  
• profLocMaxStdev - location (%) of max stdev cut  
• profMaxRStdev - max value of stdev/dn for all cuts  
• profLocMaxRStdev - location of max stdev/dn cut  

 
-t  The name of the psf_fov calibration table that codes the order to be extracted for each 

FOVID, the default ridge location, and the extraction aperture width at a fiducial 
wavelength.  

 
-w  The name of the wavsamp.tbl file. This file specifies the location of the spectral orders on 

the array in x-y coordinates. It consists of psuedorectangles, which describe the fractional 
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pixels that comprise each wavelength in the spectrum. You should choose the appropriate 
file in the cal/ subdirectory of your SPICE installation. The file you choose should match 
both the Spitzer pipeline version with which your data were processed, and the IRS 
module with which you are working.  

 
-c  The Profile module divides each pseudorectangle into this number of cuts and integrates 

the signal within each cut. Allowed values are integers between 1 and 2000. We 
recommend that users keep this at the default value (1000 for SL and LL modules, 200 
for SH and LH) adopted by the SPICE GUI. 

 
-m  Size of sliding median. Allowed values are odd integers between 1 and 21. Default value 

is 7. 
 
-v  Level of verbosity, integer. Default value is 1 
 
-ord  This selects which orders are included in the median-combined profile. The default is to 

include only the targeted orders in the profile. For hi-res observations, this is all orders, 
but for lo-res observations it is usually not. You can specify up to 14 comma-separated 
integers – no spaces, where the lo-res orders are designated as 1, 2 and 3, and the hi-res 
ones run from 11-20.  

 
-n  Name of a namelist file listing all the input parameters. This can be used instead of 

specifying all of the flags on the command line. Default is namelist.nl. 
 
The Profile module will generate a profile table of the wavelength-collapsed average spatial 
profile for the selected orders. Below is a plot of the data in this table. In this particular case, we 
see two features - a positive one on the left and a negative one on the right. The left peak 
represents the background-subtracted nod 1 spectrum, while the right-hand dip represents the sky 
background in the nod 1 image minus the nod 2 spectrum. 
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A.4 Ridge 

To run, type:  

unix% ridge <option flag> <specification> 

 
where the options are as follows:   
 
-p   The output table from running the Profile module in the previous step. 
 
-f   The *fov.tbl file, which codes the order to be extracted for each FOVID, the default ridge 

location, and the extraction aperture width at a fiducial wavelength. 
 
-m   The number of points to use for median filtering (LO-RES only). Must be ODD. 
 
-s  The number of sigma to require the peak to be above the mean (LO-RES only). Must be 

between 0.0 and 10 (inclusive). The default is 5. 
 
-g   The width, given in plus-or-minus percent of the array in the cross-dispersion direction, 

to be analyzed, centered on expected position (LO-RES only). Allowed values are floats 
from 0.0 to 100, default is 100.0. e.g. if you wish to include 25% of the array either side 
of the profile center, giving you a total extraction width of 50% of the array, you would 
set a value of 25.0.  

 
-glo Explicitly specify the low-end cutoff of g (LO-RES only). Allowed values are specified 

in percent, and are floats from 0.0 to 100. Default is to use the value set by the flag –g. 
 
-ghi Explicitly specify the high-end cutoff of g (LO-RES only). Allowed values are specified 

in percent, and are floats from 0.0 to 100. Default is to use the value set by the flag –g. 
 
-o   The output table containing the x,y position of the peak for each order and each 

wavelength. Default is <input file>.ridge.tbl. 
 
-i   The name of the *wavsamp.tbl file. This file specifies the location of the spectral orders 

on the array in x-y coordinates. It consists of pseudorectangles, which describe the 
fractional pixels that comprise each wavelength in the spectrum. You should choose the 
appropriate file in the cal/ subdirectory of your SPICE installation. The file you choose 
should match both the Spitzer pipeline version with which your data were processed and 
the IRS module with which you are working. 

 
-c Explicitly select the ridge position (a percentage fromo 0.0 to 100.0). The default is to 

compute the position automatically from the profile.  
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-v Level of verbosity. Integer. Default value = 1.  
 
-n Name of a namelist file listing all the input parameters. This can be used instead of 

specifying all of the flags on the command line. Default is namelist.nl. 
 
The RIDGE module outputs a table, *.ridge.tbl, containing the x,y position of the peak for each 
order and each wavelength.   

A.5 Extract 

To run, type:  

unix% extract <option flag> <specification> 

 
Where the options are as follows:  
 
-i   The name of the input 2D spectrum from which you wish to extract a 1D spectrum.  
 
-o   The name of the output table, which will contain the 1D spectrum in units of 

electrons per second.  
 
-b   The name of the mask file that goes with the input 2D spectrum. 
 
-fix   This controls if the NaNs should be replaced with approximated values before doing 

extraction. A value of 0 means “don’t replace”, while an integer, N, means that for 
each NaN pixel, the N rows above and N rows below are averaged column by 
column within the order, and then a line is fit to these column averages to 
approximate the NaN. Default is 2.  

 
-nanDrop   Wavelength bins with NaNs will be removed from the output spectrum if this is set to 

1. Default is 0, with the NaN fluxes set to -9999. 
 
-f   Fatal bit pattern for BMasks. See Appendix B for the allowed values and a 

description of how to calculate the fatal bit pattern. See §1.6 for the mask bit 
definitions. Default = 16384. 

 
-e   The name of the uncertainty file that goes with the input 2D spectrum. 
 
-r  The name of the output table from running the Ridge module in the previous step. 
 
-ord   This refers to the spectral order, and is used for low-resolution extractions only. You 

can set this to: 
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• 0 (as targeted; default) 
• 1 
• 2 (2+bonus)  
• 99 (1+2+bonus)  

 
-p   The name of the *psf_fov.tbl calibration table which codes the order to be extracted 

for each FOVID, the default ridge location, and the extraction aperture width at a 
fiducial wavelength. 

 
-height1   Sets the wavsamp height. Set to 1 to force the wavsamp height to be 1 pixel; set to 0 

to use actual height. Default = 0. 
 
-w   Width (in pixels) of the extraction aperture at the reference wavelength. Default for 

HI-RES is to use full width of the order, and for LO-RES to use the value given in 
the psf_fov table (specified with the "-p" flag). 

 
-l   Reference wavelength (in microns) of the aperture width specified with the "-w" flag. 

A value of 0 selects a constant width extraction aperture. Default is to to use the 
value given in the psf_fov table specified by the "-p" flag. 

 
-full   Extraction type;  0 = sub_slit and 1 = full_slit. Default is sub-slit if all of the 

following are true: (a) the "-w" flag is not explicitly set, (b) this is not a HI-RES 
observation, (c) this is not a LO-RES center position observation. 

 
-over   Name of output overlay file. 
 
-norm  Normalize the fluxes. Default = 0: 

• 0 = no normalization 
• 1 = divide by height of wavsamp rectangle 
• 2 = divide by area of wavsamp rectangle 

For S18.7 and later, set this to 1 for SL,LL,LH and 0 for SH. 
For S17.2, set this to 1 for LH and 0 for SL,LL,SH. 
Set this to 0 for all previous CAL_SET versions. 
 

-v Level of verbosity. Default = 1 
 
-n Name of a namelist file listing all the input parameters. This can be used instead of 

specifying all of the flags on the command line. Default is namelist.nl.   
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A.6 Optimum 

Runs the Optimal extraction algorithm. To run, type:  

unix% optimum <option flag> <specification> 

 
Where the options are as follows:  
 
-p               Input stellar profile template FITS file. 
 
 -I  The input 2D spectrum from which you wish to extract a 1D spectrum.  
 
 -u  The name of the uncertainty file that goes with the input 2D spectrum. If you do 

not specify an uncertainty file, the extraction will be profile-weighted only, and 
will use the default uncertainty value set by the flag –default_unc (see below) for 
all pixels.  

 
 -b  The name of the mask FITS file that goes with the input 2D spectrum.  
 
 -w  The name of the *wavsamp.tbl file. This file specifies the location of the spectral 

orders on the array in x-y coordinates. It consists of pseudorectangles, which 
describe the fractional pixels that comprise each wavelength in the spectrum. 
You should choose the appropriate file in the cal/ subdirectory of your SPICE 
installation. The file you choose should match both the Spitzer pipeline version 
with which your data were processed and the IRS module with which you are 
working. 

 
 -ridge The name of the output table from running the Ridge module. 
 
 -o  The name of the output extraction table file. 
 
 -r  The name of the output rectified flux FITS file. 
 
 -r_unc The name of the output rectified uncertainty FITS file. This is an optional 

intermediate product. SPICE will not write out this file unless an output filename 
is specified by the user.  

 
 -r_bmask  The name of the output rectified BMASK FITS file. This is an optional 

intermediate product. SPICE will not write out this file unless an output filename 
is specified by the user.  
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 -r_wave  The name of the output rectified wavelengths FITS file. This is an optional 
intermediate product. SPICE will not write out this file unless an output filename 
is specified by the user.  

 
 -r_ord  The name of the output rectified order numbers FITS file. This is an optional 

intermediate product. SPICE will not write out this file unless an output filename 
is specified by the user.  

 
 -r_offset  The name of the output rectified offsets FITS file. This is an optional 

intermediate product. SPICE will not write out this file unless an output filename 
is specified by the user.  

 
 -ow  The name of the output wavsamp file of rectified image. 
 
 -op  The name of the output 2D profile FITS file. 
 
 -ox  The name of the output profile ASCII file. 
 
-fatal      The Fatal Bit Pattern for the input mask file. See Appendix B for more 

information on calculating the Fatal Bit Patterns, and §1.6 for the mask bit 
definitions. Default = 0.  

 
 -area_width  Width of the rectification area in pixels. Must be an odd integer. 
 
 -pct_center   Location of the center of the source, in percent. default: -100.0, which uses the 

output from Ridge instead.  
  
 -keepnans Set this to 1 if you wish a rectified pixel to be set to NaN if any of the 

corresponding pixels in the original image are NaNs. Default is 0, which 
approximates the output value of the pixel with remaining non-NaN pixels (see 
the replprofnan parameter below).  

 
 -replprofnan    Replace NaNs in profile. If  N <= 0 then leave alone. If N > 0, estimate the value 

of the output pixels from N neighbors. Default = 3. 
 
 -height1  Sets the wavsamp height. Set to 1 to force the wavsamp height to be set to 1 

pixel. Set to 0 to use the actual height.  
 
 -resamp  Method of computing pixels in the rectified image. Default is "weighted 

bilinear": 

• 0 = nearest neighbor 
• 1 = weighted bilinear 
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• 2 = unweighted bilinear 

 
 -v  Verbosity level of printed messages. Default = 1. 
 
 -n  Name of a namelist file listing all the input parameters. This can be used instead 

of specifying all of the flags on the command line. Default is optimum.nl. 
 
 -clip_width  Width (in pixels of the original non-rectified image) of the extraction aperture at 

the reference wavelength. Default is half the width of the order.  
 
 -clip_lambda0  Reference wavelength (in microns) of the aperture width specified with the "-

clip_width" flag. Default is to use a constant width extraction aperture. 
 
 -default_unc  Sets the default uncertainty value if there is no input uncertainty file specified, or 

if a pixel value in the input file is NaN. Default is 1.0. Input units are electrons 
per second.  

 
 -unc_tune  Adjustment applied to the uncertainties in rectified space to compensate for the 

fact that they are correlated. 0.0=none. Default = 1.0. 
  
 -norm   Normalize the fluxes. Default = 0: 

• 0 = no normalization 
• 1 = divide by height of wavsamp rectangle 
• 2 = divide by area of wavsamp rectangle 

Set this to 1 for S18.7 SL,LL,LH, 0 for SH for compatibility with S18.7 flux 
calibration. 
Set this to 1 for S17.2 LH, 0 for SL,LL,SH. 
Set this to 0 for all other CAL_SET versions. 

 
-minorder Minimum order number to extract. Default = 0. 
             
 -maxorder Maximum order number to extract. Default: 99 
 
 -xnfine  Number of fine subsample points in x direction. Default = 1. 
 
 -ynfine         Number of fine subsample points in y direction. Default = 1. 
 
 -nanDrop  Wavelength bins with NaNs will be removed from the output spectrum if this is 

set to 1. Default is 0, with the NaN fluxes set to -9999. 
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 -pixel_scale  Pixel size in input image (for rec_offset file). Units are in arcsec/pixel and the 
default = 0.0.   

A.7 IRS_Tune 

IRS_Tune is run for both Point Source and Extended Source tuning. To run Extended Source 
tuning, you must include the –recom option, which calls the IRS_Retune module.  
 
To run, type:  

unix% irs_tune <option flag> <specification> 

 
Where the options are as follows:  
 
-I Name of input table. 
 
-t     Name of tuning table. 
 
-o     The desired name of the output flux-calibrated spectrum, which is written out in units 

of Jy. 
 
-m  Tuning mode (tune_up OR tune_down). Virtually all users will wish to use the 

"tune_down" option. The "tune_down" value means to apply the fluxcon table in the 
normal way, dividing by the factors. The "tune_up" value means to multiply by the 
factors. If you run irs_tune with tune_down on untuned data, you get tuned data. If you 
run irs_tune with tune_up on tuned data, you get the untuned data back. 

 
-noise0  Only for generating “untuned” spectra for testing purposes. Sigma of offset noise to 

add. Default: 0.0. 
  
-noise1  Only for generating “untuned” spectra for testing purposes. Sigma of gain noise to add. 

Default: 0.0. 
             
-v  Verbosity level of printed messages. Default = 1. 
  
-a  Tuning components from the *_fluxcon.tbl to apply. Default = 3. “Fluxcon” is the 

conversion factor from electrons per second to Jy, while “tune” applies the remaining 
calibration factors. Users will usually want to apply both to their data.  

• 1 = fluxcon, 
• 2 = tune,  
• 3 = both 
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-recom  Calls the IRS_Retune module (see below), which allows tuning for extended sources. 

Do not use this if you are tuning for point sources. The value of this option must be the 
full path to the irs_retune executable. 

 
-retab  Input retuning table. Only used when –recom is turned on 
 
-reout  Retune output file. Only used when –recom is turned on.  
 
-retab2   Second input retune table. Only used when –recom is turned on. 
 
-reout2    Second retune output file. Only used when –recom is turned on. 
 
-n  Name of a namelist file listing all the input parameters. This can be used instead of 

specifying all of the flags on the command line. Default is namelist.nl. 
 

A.8 IRS_Retune 

Usually this module is called from within IRS_Tune with the –recom flag. To run as a stand-
alone, type:  

unix% irs_retune <option flag> <specification> 

 
Where the options are as follows:  
 
-i  Name of input table. 
 
-t  Name of tuning table. 
 
-o  Name of output table 
 
-v  Verbosity level of printed messages. Default = 1. 
 
 



  SPICE User’s Guide 

 

Fatal Bit Patterns 53 A.8 IRS_Retune 

 

 

Appendix B. Fatal Bit Patterns 
 
 
It is highly likely that when you reduce your Spitzer data, you will include the BMask files as 
input into SPICE. The pixels in the mask files all contain coded information, or "bit definitions", 
depending on the status of a particular pixel. For example, a pixel with bit 10 flagged in the 
BMask file indicates that that particular pixel in the data frame is saturated, while bit 14 indicates 
that the pixel was flagged as fatal in the PMask. For a full list of bit definitions, see the IRS 
Instrument Handbook or see Table 1.6.1 in this manual for a list of current BMask bit definitions. 
When running SPICE, you need to decide which of these codes you wish to set as "fatal", i.e. 
which of the flagged problems you consider so bad that the corresponding pixel in your data 
frame should be discarded. This is done by specifying a "Fatal Bit Pattern" as follows: 
 
Fatal Bit Pattern = 2(value of 1st required fatal bit) + 2(value of 2nd fatal bit) + .... + 2(value of nth fatal bit) 
 
e.g. if you wished to set bits 7, 8, 9, 10 and 14 as fatal for your IRS BMask file then your BMask 
Fatal Bit Pattern would be: (27 + 28 + 29 + 210 + 214) = 18304. 
 
The most up-to-date recommended Fatal Bit Patterns can be found in the IRS Instrument 
Handbook.  
 

http://irsa.ipac.caltech.edu/data/SPITZER/docs/irs/irsinstrumenthandbook/�
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